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Putting Flash Online
From the book Flash Journalism by Mindy McAdams

Before you became interested in Flash, you probably spent at least a little time creating Web pages
and putting them online. If you wrote HTML by hand, you probably used an FTP (File Transfer
Protocol) program to upload the pages and graphics to a Web server. If you used Dreamweaver, or
another Web authoring application, the ability to send files to the server was built into the program.

While you could simply upload the .swf file (which, as you learned in Lesson 2, is generated when
you press Ctrl-Enter or Cmd-Return to test the movie) and open it in a Web browser directly, that
would not afford the best presentation for your Flash movie. It would be enlarged (but not skewed)
to fill the browser window. The movie could not have any surrounding content (which you could
add if you embedded your movie in a Web page). If you opened the movie in a pop-up window,
the window title would be the same as the SWF's filename, rather than a title of your choosing.

This lesson explains how to make your Flash movie appear as you want it to appear to users on the
Web.

Lesson

There are two standard ways to present an SWF on the Web: As a pop-up window linked from a
Web page, or as an object embedded in a Web page (usually with other content on the page). In
either case, you should "publish" your movie (File menu > Publish). This does not upload your file(s) to
a Web server-it generates the files that you will later upload, using other software. Before you publish
those files, though, you should check-and possibly change-your "Publish Settings" (also selected from
the File menu).

This lesson covers:

•The most common Publish Settings.
•What you need to know to create a Web page layout using embedded Flash content.
•How to handle the files and put them online.
• Two ways to create a pop-up window to display your Flash movie.

Exercise: Publish Settings

1. You can use the movie you already created for this exercise. Open the file in Flash, and then
select "Publish Settings" from the File menu.

2. The Publish Settings dialog box normally has three tabs: Formats,  Flash, and HTML. It can have
more or fewer tabs, depending on the items you select under the Formats tab. Here is a summary of
those three option sets.



Formats

Under the first tab, the options for output are listed.

• Normally, only the top two options are checked: "Flash (.swf)" and "HTML (.html)." In almost all
cases, you will keep both of these checked.
• You can uncheck "HTML (.html)" if you know you need nothing but the SWF. If you embed the
Flash movie in a Web page, you may need the OBJECT code Flash generates for HTML, so it never
hurts to keep that checkmark.
• The other format options are less commonly used and will not be covered here. They are
described in detail in the Flash Help files (press F1; in Flash MX, go to "Using Flash," then find
"Publishing" near the end of the Contents listing; in Flash MX 2004, under "Common Tasks," open
"Publish a Flash document").

Flash

Under the second tab, you select settings for the SWF that will be generated.

• You can change the player required to an earlier version to accommodate a larger number of
online users (but there's no real reason to go back further than Flash 5*). [footnote below] If you do
this, make sure you have not used any functionality that is unavailable to the older player version.
For example, Flash MX (6) introduced "components," such as the ScrollBar. If you use the ScrollBar
component in your movie, you cannot select a version before 6.
• "Load Order" is typically "Bottom up." It determines which layers Flash renders first as the movie
loads for the user.
• In Flash MX 2004, you can select the ActionScript version you are using. For all exercises in this
book, you can use ActionScript 1.0.
• The "Options" usually checked are "Protect from import" and "Compress Movie." The first prevents
other people who download your SWF from importing it to Flash and converting it back to an FLA
file. The second is not available in versions before Flash MX (6). Compressing the movie makes the
file size smaller; Macromedia says the biggest advantage comes for files with a lot of text or
ActionScript. This setting does not affect images!
• The "JPEG Quality" setting is discussed in Lesson 7. Changing this setting does not affect the quality
of imported JPG images! However, it does affect the quality of imported BMP or PICT files.
• The other settings under the second tab usually stay as they are. More details appear in the Flash
Help files.

HTML

Under the third tab, you select settings for the HTML page that will be generated.

• The default template ("Flash Only") will be fine for your first movies, but later you may want to
determine whether your users have the appropriate Flash player version to view your movie. If you
choose to detect for Flash 6, for example, Flash will generate a Web page that includes many lines
of JavaScript; the script tests the user's system for the Flash player version and reacts accordingly. (If
you include video in your Flash movie, for example, and you do not include this JavaScript, the Flash
movie will play for a user who has the Flash 5 player, but the video in the movie will not play at all.)
• "Match Movie" (Dimensions) works best in most cases. It shows your SWF at the size you set in the
Properties panel. ("Pixels" requires you to enter the width and height in pixels. "Percent" allows you to
set a percentage relative to the size of the user's browser window.)
• Developers often change some of the four "Playback" options:
o Leave "Paused At Start" unchecked; otherwise, you will need to include a button just to start
the movie.
o If you uncheck "Display Menu," it changes what appears on the menu your users get when



they right-click  (Control-click/Mac) on your movie-but only if you embed the movie in a Web page.
If "Display Menu"  is unchecked and the movie is embedded, then the right-click menu shows only
two lines: "Settings" and "About Flash Player." In other cases, it lists many options, such as "Zoom In"
and "Rewind" (see Figure 3.06).
o "Loop" is checked by default. Leave it checked if you want your movie to repeat continuous-
ly. Unchecking it will cause your movie to play once and stop, but only if the movie is embedded in
a Web page-the SWF will loop when opened by itself. (To ensure that a movie stops when you want
it to stop, use ActionScript as described under "Animating Two Symbols," Steps 20-23, in Lesson 2.)
o Leave "Device Font" unchecked. (This is explained further in Lesson 9.)
• The other settings under the third tab usually stay as they are. More details appear in the Flash
Help files.

3. After you have selected the Publish Settings you want, click the Publish button on the dialog
box to generate the files. (If you click OK, the Publish Settings are saved, but no files are generated!
This is a common error for new Flash authors.) If you do not want to save the new settings, click
Cancel. If you save the settings (by clicking OK), they will be in effect the next time you select
"Publish" from the File menu (in this FLA only).

4. At this point, if you clicked the Publish button, you have an SWF file (the playable Flash
movie) and an HTML file. If you find the HTML file and double-click it, it will open in your default Web
browser, and your Flash movie will play. In most cases, the position of the movie will be as shown in
Figure 3.01.

The browser window will also be its full size (whatever that might be on the user's computer-it varies
widely), and not the exact size of your Flash movie.

Insert Web site icon

Insert Figure 3.01
Caption: By default, the HTML page generated by Flash places the movie alone on the page, in the
upper left corner.

5. You can also locate and double-click the SWF file that was generated when you clicked the
Publish button. It will open and play in the stand-alone Flash player.

Remember that when you "publish" from Flash, you have not uploaded your files to the Web. You
must do that separately, from another application such as Dreamweaver.

************************************

Where Are Your Files?

When you publish a Flash movie, Flash puts all the files generated into the same folder with your FLA
file. It does not ask where you want to save the new files.

It makes good sense to create a separate project folder for each Flash movie you create, so that all
the associated files are kept together and remain easy to find and manage. If you have copied an
FLA file into a new folder, make sure you open that file in Flash from the new folder. Then, whenever
you publish, the associated files will go inside the new folder.

************************************



Positioning a Flash Movie in the Browser Window

You probably want to have control over your Web page layout. Instead of using the simple HTML
page that Flash generates, you will insert the Flash object where you want it to appear within your
own layout design. Web developers typically create a page layout with an HTML table, CSS, or a
combination of the two.

There are several possibilities for embedding the Flash object in your page. You can:
• Insert the Flash object directly, if your authoring application offers that feature (see the box
"Inserting an SWF with Dreamweaver").
• Open the HTML page "published" by Flash and edit it as you like in any Web authoring application.
• Copy the code from that HTML file and paste it into another page that you have created.

If you edit the HTML page, or copy the code, be very careful not to lose any of the code that Flash
generated! Flash generates code in one of two standard ways (in most cases), depending on the
choices you made in the Publish Settings dialog.

Object and Embed Tags

If you accepted the default setting (in Publish Settings, you kept "Flash Only" as your template under
the third tab, as described above), you have a chunk of OBJECT code to manage. It begins with
this:

<OBJECT classid=

The opening tag is followed by several parameters and (quite important) an EMBED tag that
repeats the same parameters in a different format. All the code is necessary to ensure that your
Flash movie plays across multiple Web browsers.

The code ends with this:

</OBJECT>

If you want to position your Flash movie within a table cell (in a layout table in HTML), you must not
lose or delete any of the OBJECT code. Sometimes developers go into the code and edit it, but
they forget that all the instructions are given twice (once in the OBJECT tag and once in the EMBED
tag), so they make errors, and the Flash movie fails to play for some Web users.

JavaScript for Player Version Detection

If you want to test for the Flash player version (in Publish Settings, you chose to detect for a specific
Flash version, under "Template" on the HTML tab, as described above), you have a big clump of
JavaScript to manage. It begins with this:

<script LANGUAGE=JavaScript1.1>

It ends with something similar to this:

</SCRIPT><noscript><img SRC="test.gif" WIDTH="550" HEIGHT="400" usemap="#test"
BORDER=0></noscript>

If you want to position your Flash movie, for example, within a table cell (in a layout table in HTML),
you must not lose or delete any of the JavaScript. Sometimes developers go into the script and edit
it, but they forget that all the instructions are given twice (the JavaScript is actually writing the



OBJECT tag and the EMBED tag), so they make errors, and the Flash movie fails to play for some
Web users.

Another common mistake: Failure to include a GIF, as specified at the end of the script. Flash will
generate this GIF for you if you select "GIF Image (.gif)" under the Formats tab in the "Publish
Settings" dialog; the GIF generated by default will show the contents of the first frame of your movie.
If that's not the frame you want users to see as a stand-in for your movie, create an appropriate GIF,
and include it in the same folder with your HTML and SWF files for the movie. You can make Flash
generate any frame from your movie as a GIF image; see the Flash Help files.

Basically, you must tell Flash which frame you want to output as a GIF by putting a special label on
that frame. (Frame labels are explained in Lesson 5.) Then select "GIF" in the Publish Settings dialog,
and click  the Publish button. Flash will save the labeled keyframe as a GIF.

***********************************

Inserting a SWF with Dreamweaver

If you use Macromedia Dreamweaver for Web page authoring and editing, you can insert any SWF
exactly as you insert an image. First, copy the SWF into your site folder.

In Dreamweaver MX, find the Flash icon on the Insert bar (when the Common tab is selected), near
the top of the Dreamweaver application window (Figure 3.03). Click it, find the SWF file in your site
folder, and select the SWF. The Flash content will be inserted into your document at the cursor posi-
tion.

In Dreamweaver MX 2004, the Flash icon is on a submenu of the Insert bar (when Common is select-
ed). Find the Media icon and click it to open the submenu, then select "Flash" on the submenu
(Figure 3.04). Find the SWF file in your site folder, and select the SWF. The Flash content will be insert-
ed into your document at the cursor position. Note that after you have done this once, in most
cases the Media icon will change to a Flash icon (Figure 3.05), which you can click directly next
time, without opening the submenu. 

***********************************

Exercise: Creating the Page Layout and Uploading the Page

Think of your SWF file as a rectangle, much like a GIF or JPG that you would include on any regular
Web page. You can position the SWF anywhere you would normally position a GIF or JPG.

1. Copy the SWF file and the HTML file, and paste both of them into the folder on your hard
drive where you keep your other Web site files. (This step is crucial!)

2. Open the HTML file that Flash generated when you published the movie. You can open it in
any Web authoring program, or in a text editor.

3. There are several ways you can handle the layout. In all cases, treat the Flash code (either
the OBJECT tag or JavaScript) as you would a GIF or a JPG file. Remember that your movie has a
width and height (see Lesson 1, Step 2), and it will usually look best if it is displayed at that same
width and height on the Web page.

• If you have a page layout already designed, open that page also. If you use Dreamweaver, and
you are not using a player version detection script, use the method described in the box "Inserting



an SWF with Dreamweaver."
• If you use another Web authoring program, or you are using a player version detection script,
select all the Flash code in the Flash-generated HTML file (as described above) and copy it. Switch
to your page layout file and paste the code into the desired position in that page.
• If you want to create a new page layout within the Flash-generated HTML file, add your table
and/or CSS code above and below the Flash code, without altering the Flash code. In other words,
keep the block of Flash code intact, either inside a table cell (TD tags) or within DIV tags.

4. Save the page layout file in your Web authoring application, into the folder where you keep
your other Web site files.

5. Upload both the HTML file and the SWF to your Web server. (The SWF uploads exactly like a
GIF or JPG file.)

*****************************

Very Important Note About File Locations

The code Flash generates (whether it is the raw OBJECT tag, or JavaScript for player version detec-
tion) assumes that the SWF file is in the same folder with the HTML file. If you put the SWF elsewhere,
then you must edit the Flash code to provide the correct path to the SWF. You must change the
path code twice, once in a PARAM attribute and once in the EMBED tag.

Flash writes this to show the location of the SWF file:

PARAM NAME=movie VALUE="test.swf"
EMBED src="test.swf"

If you move your SWF file to a folder named "flash" inside a folder named "mediafiles," you must
rewrite the code, to include the new path:

PARAM NAME=movie VALUE="mediafiles/flash/test.swf"
EMBED src="mediafiles/flash/test.swf"

Failure to do this causes the Flash content not to display on the page, because the Web browser
cannot locate the SWF file after you have moved it.

*****************************

Exercise: Using a Pop-up Window

Making a pop-up window requires a small amount of JavaScript, which is essentially the same for
both window options you might use to display a Flash movie. The first case uses the SWF in the win-
dow without embedding it in a Web page at all (although the pop-up window is generated by
script on a Web page). The second case uses a Web page with the SWF embedded in it, such as
the HTML file that Flash can produce for you when you "publish" the movie, as described above.

Three advantages make Case No. 2 superior:

• Choices you made regarding Flash's pop-up menu (in the "Publish Settings" dialog) will be in
effect, because the SWF is embedded in HTML.
• The pop-up window will have an appropriate title in the title bar.
• You can allow the user to resize the window, but the SWF will not resize.



For both cases below, the Flash movie file is named test.swf and the width is 300 pixels and the
height is 200 pixels.

Case No. 1: SWF Alone

1. On the page that will generate the pop-up window, create a regular hypertext link, but with-
out a URL:

<a href="">Open my Flash movie!</a>

2. Insert this between the quotation marks in the tag shown above:

javascript:openFlash('test','300','200');

3. Insert this code anywhere on the page:

<script language="JavaScript" type="text/JavaScript">
var myWindow;
function openFlash(winurl,winwidth,winheight)  {
myWindow = window.open(winurl+".swf",winurl,"width=" 
+ winwidth + ",height=" + winheight + ",resizable");
myWindow.focus();
}
</script>

4. Save the HTML file.

5. Upload both the HTML file and the SWF to your Web server. (The SWF uploads exactly like a
GIF or JPG file.)

This works in just about any browser and produces no odd behavior. It assumes that your SWF file is
in the same folder as the HTML file. The window will not have scrollbars.

Note: If you prefer to use an option in your Web editing software to generate pop-up windows, with-
out writing the JavaScript yourself, follow the instructions in "Case No. 2" below to prepare the HTML
file with the SWF embedded in it. Then use that file as the URL for the pop-up window.

If you want to prevent users from changing the size of the pop-up window, use this code instead:

<script language="JavaScript" type="text/JavaScript">
var myWindow;
function openFlash(winurl,winwidth,winheight)  {
myWindow = window.open(winurl+".swf",winurl,"width=" 
+ winwidth + ",height=" + winheight);
myWindow.focus();
}
</script>

Resizing the Flash movie (bigger or smaller) is perfectly okay as long as there are no bitmaps in your
movie. Basically a bitmap in Flash is any imported image such as a JPG or GIF. If the user changes
the size of the SWF by resizing the window, the bitmaps become very ugly because the pixels get
stretched. In other words, the bitmap images (including photos) become jagged and lumpy. Flash
text and graphics don't do this because they are made up of vectors, not pixels (see Lesson 7 for
details).



Case No. 2: SWF and HTML Together

1. Use the HTML file that Flash generated when you published the FLA file, as described in
Exercise 3.1 above. You will make exactly two changes to that file.

2. The first change to the file: If you want the Flash movie to appear without any excess space
around its edges (and normally, you do want that), you must tell all the Web browsers to reset their
default page margins. There are several ways to do this, depending on whether you use CSS or not. 

If you don't use CSS, add these four attributes to the BODY tag of the page in which the SWF is
embedded:

leftmargin=0 topmargin=0 marginwidth=0 marginheight=0

(In Dreamweaver, open Page Properties from the Modify menu and type 0 into the four fields
labeled "Left Margin," "Top Margin," "Margin Width," and "Margin Height.")

If you use CSS, this does it:

body { margin: 0; }

3. The second change to the file: If you want the pop-up window to have a meaningful title in
the title bar (and normally, you do want that),  write one. If you're in the HTML code, find the TITLE
tags near the top of the file. In Dreamweaver, open Page Properties from the Modify menu and
type your title into the field labeled "Title."

4. Save the file. It is complete.

5. Create (or open) a separate HTML file, which will open as a normal full-size window, and cre-
ate the link to your pop-up window as described in "Case No. 1" above. The single difference in cre-
ating this type is that you are not opening the SWF, so instead of this code:

myWindow = window.open(winurl+".swf",

You need the .html (or .htm) file extension, instead. For example:

myWindow = window.open(winurl+".html",

By default, Flash appends the .html file extension when it generates an HTML file.

You must also be sure to use the filename of the HTML file that contains the SWF (the file you just
saved). If you saved it as popup.htm, for example, then this is correct:

javascript:openFlash('popup','300','200');

The width and height should exactly match your Flash movie, as in Case No. 1.

6. Save the second HTML file.

7. Upload both HTML files and the SWF to your Web server. (The SWF uploads exactly like a GIF
or JPG file.)



If you want to allow the user to resize the movie, follow the steps in Case No. 1, above.

If you have followed the steps for Case No. 2, you have three files to upload to your Web server: the
SWF and two HTML pages.

Putting Flash Online Summary

If you think of the Flash movie object as a page element similar to an image, and remember that
the SWF file is not so different from a GIF or JPG file, you should have no trouble managing the file
and folder issues associated with Flash. They are the same issues that arise with all Web sites and all
HTML files. Make sure you use the correct filenames and folder names, put the files where they
belong, and everything will go smoothly. Upload your files exactly as you would any other set of files
for your Web site.

In the same vein, when you want to put a Flash movie on a page, or in a pop-up window, the
object behaves the same way as an image: It takes up a certain amount of space, and it will align
inside a table just as an image will, if you give it the code.

As you create more complex Flash movies, you may want to do more with the Publish Settings. At
the beginning, you can probably set them up once and then forget about them. Don't make the
mistake of rewriting the OBJECT code incompletely, however! If you decide not to publish an HTML
file and instead recycle your old code (there's no compelling reason to do this, but some people
do), remember that all the parameters for the movie appear two times in the code block.

Conclusion

In this lesson, you have learned to:

1. Select appropriate Publish Settings for your Flash movie.
2. "Publish" both SWF and HTML files from Flash.
3. Anticipate where Flash will put the files it generates.
4. Recognize the code Flash generates for use in an HTML file, depending on your selections in
the Publish Settings dialog.
5. Copy that code successfully for use in various page layouts.
6. Position the Flash movie within a page layout that includes text and other elements.
7. Insert a SWF using a Dreamweaver Insert bar button.
8. Edit the Flash-generated code successfully, if you have changed the location of your SWF
file.
9. Create a link that opens a separate pop-up window (via JavaScript) containing either the
SWF or an HTML page with the SWF embedded in it.
10. Use the Flash-generated SWF alone in a pop-up window.
11. Edit and use the Flash-generated HTML in a pop-up window.
12. Upload your files to your Web server.


